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Introduction
From the beginning FrameMaker could be customised.

 Menus can be switched from complete to quick. This is a 
standard feature.

 Menus can be modified.

 Commands can be created and referenced in menus and 
toolbars.

Until the arrival of the new user interface with FM-9 the pro-
cess was described in an Adobe file, which was lastly issued 
for FM-7. The text provided by this file was grosso modo still 
valid for FM 11. However, the new interface requires signifi-
cantly more information, which is not available from Adobe 
until now.

Document history

This document is not
sacrosanct. In particular it

has not been verified by
Adobe and hence may

contain errors or
misinterpretations.

Readers are requested to
communicate errors or

enhancements to the author
klaus(daube.ch)

2014-05 Clarify the situation with non-existing toolbar-
icons.

2014-09 Check the situation with FM-13-M1. It seems that 
nothing related to the customisation has changed.

2015-03 Reworking the structure of the document in some 
places to get a ‘more logical’ sequence.

2015-12 Add text concerning scripts as commands. Amend 
the example toolbar with this.

2016.01 Change the document title to reflect scope of docu-
ment; rework structure; add scheme and examples.

2016-02 Clarifications concerning command names from 
scripts and plugins, clean up the example files.

2016-12 “Shortcuts in ExtendScript” added.

2017-04 Additional menu customisation example; better 
explanation for hypertext commands and scripts.

Sources  Experiments and beta testing activities.

 Communication in FrameMaker related forums as well as 
personal communication with members of these forums. 

 (Very sparse) communication with Adobe developers.

 User guides for FrameMaker.

 Adobe blogs

 Video: Getting started with the new FM-9 UI

 Video: Workspace overview

 Video: Customize and manage the Workspace

Explanation of fonts and 
highlights

Menus and names from the user interface are in > this > font.

Variables (place holders) use italic script.

Keywords and the like are in fixed pitch font.

This is sample code

http://blogs.adobe.com/techcomm/
https://admin.adobe.acrobat.com/_a295153/p17912987/
http://help.adobe.com/en_US/FrameMaker/9.0/Using/WSC489C733-22A5-4271-B024-8B8DFF7238F9.html
http://help.adobe.com/en_US/FrameMaker/9.0/Using/WS7276CAA0-156D-4e8c-AF4C-DD12CB3B29E7.html
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Terminology

Note: IMHO the terminology of FM has not yet settled. The term pod 
should be eliminated - but is used since FM-9 and confuses 
more than it clarifies. Panel, palette and dialogue are some-
what synonymous. Terminology is not coherent between the 
workspace files, the tool tips and context menus.

For better understanding of some terms look at the picture 
Elements of the workspace on page 5

$HOME The FM installation directory. In my case this is 
H:\Adobe\FrameMaker.12en\AdobeFrameMaker12 - and
H:\Adobe\FrameMaker.13en\AdobeFrameMaker20151).

Access character An access character2) in a menu item is preceded by the ‘&’ 
symbol (e.g. E&xit). 

In Windows 7 and beyond these access characters are visible 
at the menu items only when pressing the left ALT key. To 
use the short cut for Exit, you type left ALT f x. 

Dialogue Prior to FM-9 a dialogue was either modal or non modal. Some 
of these have been replaced by dockable panels which can be 
grouped into panel groups and minimised to icons.

Even in FM-12 there are still many of the old dialogues active.

Dock A dock is an area on the application window to which UI ele-
ments can be docked (anchored) and aligned. 

FCode The function code is the connection between the command 
(as defined in a configuration file such as cmd.cfg) and the 
routine in the application which performs the function.

Menus and commands The UI information basically is split into 2 groups:

 Command sets assembled according to views.

 Menus and tool bars assemble according to views.

modal vs. non-modal  A modal dialogue must be closed before work can continue 
on the document.

 A non-modal dialogue could stay open like a palette.

Panel A docked or undocked dialogue, which need not be closed to 
work on the document. The automatic behaviour depends on 
Preferences > General > Interface > Pods.

Panel group A collection of panels which can be handled as a whole.

Pod A dockable panel. This seem to be a synonym for panel. The 
term was first used in RoboHelp.

1 The installation program does not allow to modify the last level. This is 
due to new mechanism (introduced with FM-10) using a data base for in-
stallation/de-installation.

2 The Adobe document calls this a mnemonic shortcut. The access character 
must be carefully chosen to avoid duplicates within a menu.

Dock content What can be in

palatte toolbar Iconised or expanded dialogs/pds, the graphics palette

multi-controlbar Horizontal groups of toolbars on top of the application 
window

palette Special tab panes such as the bottom pod (palette-kit data)
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UI User interface. The elements of user interaction: windows, 
panes, menus and dialogues. Also keyboard shortcuts belong 
into this category.

Palette This term was first used in FM for the read-only FM-docu-
ments which behave as non modal dialogues (Equation pal-
ette, Vertical toolbar, Template browser, Element catalogue 
…). This term is still used in the workspace files.

Product interface FM≥12 contains three product interfaces (also known as 
modes): Structured, UnStructured and XMLAuthor. XMLAuthor 
is a stripped down version of the structured interface and 
also available as own product.

Toolbars Toolbars are an alternative to menus for a desired function.

User-area In Windows 7 this is 
C:\Users\user\AppData\Roaming\Adobe\FrameMaker\11\

View Views were introduced with FM-11. A view groups elements of 
a workspace. Hence there are more menus and toolbar groups 
than before FM-11.

In Structured mode there are three views: XMLView, AuthorView, 
and WYSIWYGView. See Relationship between the UI files on 
page 10. These are represented as icons in the top right hand 
corner before the Workspace selection:

Unstructured mode knows only the WYSIWYGView. In the above 
picture this is the rightmost icon (active).

This has consequences for the customisation: it is no more 
sufficient to have a $HOME\fminit\configui\cstomui.cfg file. 
The contents of such a file must also be appended to a menu 
file.

Workspace A workspace is a saved set of frequently used panels/toolbars 
in a desired arrangement for repeated use.
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Elements of the 
workspace

The workspace contains various elements, which are demon-
strated on the following screen shot:

1 Menu bar

2 Arrangement panel. A chosen arrangement (e.g. 2 docu-
ment panes side by side) is not saved in the workspace file.

3 Multi control bar (dock) spanning multiple rows of tool 
bars. In the workspace file a row of this is a Control Bar 
Pane.

4 Toolbar, docked. In the workspace file this is a Control Bar.

5 Toolbar, undocked = floating

6 Graphic toolbar (undocked, horizontal arrangement)

7 Tab group (docked ) with minimised panels.

8 Tab group (undocked)

9 Bottom pod - a special palette.

If used, work space information (workspace, tool bars, 
menus), are copied from $HOME to the user area. Any modifica-
tions are only kept there.

For details see Relationship between the UI files on page 10.

General procedure for customisation

If a requirement can not be satisfied with entries in the 
Initialisation files maker.ini and others on page 49, consider set-
ting up a custom workspace:

1 For special menu entries set up a custom menu file by 
means of customui.cfg and append it to the relevant 
menus.

1 2

5

3
4

2

7

6

8

9
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2 A custom toolbar requires creation of a custom-toolbar.xml 
file and a modification of the toolbar set file fmtoolbar.xml. 
It may require the creation of button images.

3 For both cases it may be necessary to define new com-
mands in customui.cfg (which must be appended to the rel-
evant menus).

4 To define a custom workspace copy an existing workspace 
file (xxx.fws) to a custom named file and modify the refer-
ences to menu and toolbar set.

Download example 
customisation

You can download the example customisation files from my 
website.

http://daube.ch/docu/files/FM-customisation-example.zip
http://daube.ch/docu/files/FM-customisation-example.zip
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UI properties

Workspaces

A workspace is a saved set of frequently used panels/toolbars 
in a desired arrangement for repeated use. It also offers flexi-
bility of screen usage, by allowing a user to place panels in 
numerous possible forms/arrangements: default, iconic, mini-
mized, docked (left, right, bottom, top), floating, grouped.

The workspace remembers the dialogues that were open at 
the previous session and also their positions, size, state etc.

FrameMaker ships with a set of standard Workspaces tailored 
for different tasks. They can be modified and then saved with 
a new name. FM also provides an empty workspace to start 
with.

Modifications to a workspace are temporary (until saved) and 
can be reversed by Reset.

The last used workspace is noted in maker.ini. The workspace 
is loaded with the first document to open. This open may be 
considered slow. No workspace is loaded with a book file.

The workspace does not contain the arrangement of docu-
ments (available with the drop down menu of  located 
to the right of the menu area).

Workspaces are saved in the user-area. The current workspace 
is in xxx.cfws, while the last saved is in xxx.fws. See 
Relationship between the UI files on page 10.

At the first use of workspaces the necessary files (workspace 
definition, toolbars, menus) are taken from $HOME and copied 
to the user-area.

To design a new workspace for a specific task, open all the 
required panels and save the Workspace using Save 
Workspace. The names are case sensitive.

}

}
Custom workspaces

Initial workspaces
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Toolbars

Tool-set The toolbars available for the UI are listed in an xml file which 
is referenced in the workspace file (see Relationship between 
the UI files on page 10). The standard name is fmtoolbar.xml3). 
There may be more toolbar files, but only those listed in this 
file are visible in the menu.

Toolbar The toolbars themselves are defined in xml files The only tool-
bar which can not be customised is the graphics tool palette.

Toolbars can be docked in the top toolbar pane, to the right 
or left of the application window or undocked (floating).

Note: Toolbars containing a drop-down list can not be docked to the 
left or right!

3 A much clearer term would be toolbar-set.xml

fmtoolbar.xml

<?xml version="1.0" encoding="UTF-8"?>
<FMTOOLBARLIST version="1">
  <TOOLBAR file="graphics.xml"/>
  <SEPARATOR sep_id="0"/>
  <TOOLBAR file="quick_access.xml"/>
  <TOOLBAR file="structured.xml"/>
  <SEPARATOR sep_id="1"/>
  <TOOLBAR file="text_format.xml"/>
  <TOOLBAR file="table_format.xml"/>
  <TOOLBAR file="para_format.xml"/>
  <SEPARATOR sep_id="2"/>
  <TOOLBAR file="align_object.xml"/>
  <TOOLBAR file="object_properties.xml"/>
  <SEPARATOR sep_id="3"/>
  <TOOLBAR file="trackchanges.xml"/>
</FMTOOLBARLIST>
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Files for the UI

If used, work spaces are copied to the user area. Any modifi-
cations are kept only there.

FM-12 and later contains three interfaces: Structured, 
UnStructured and XMLAuthor. XMLAuthor is a stripped down ver-
sion of the structured interface and also available as own 
product. It is not elaborated further here.

The UI information basically is split into 2 groups:

 Command sets assembled according to views

 Menus and tool bars assembles according to views.

Product interface Structured Unstructured

View AuthorView CodeView (XML) WYSIWYG WYSIWYG

Standard commands Commands independet of views are located in $HOME\fminit\configui: cmds.cfg

Commands a mathcmds.cfg
wincmds.cfg

wincmds.cfg mathcmds.cfg
wincmds.cfg

mathcmds.cfg
wincmds.cfg

Work spaces b Authoring.fws
none.fws c

Authoring.fws
none.fws

Authoring.fws
Blank.fws
Design.fws
Manage Graphics.fws
none.fws
Review.fws
Structured Authoring…

Authoring.fws
Blank.fws
Design.fws
Manage Graphics.fws
none.fwsReview.fws

Menus menus.cfg menus.cfg menus.cfg
menus_review.cfg
menus_structured_au-
thoring.cfg
menus_ts.cfg d

menus.cfg
menus_review.cfg
menus_ts.cfg

Tool bars fmtoolbar.xml e

graphics.xml
quick_access.xml
quick_element.xml
structured.xml
trackchanges.xml

fmtoolbar.xml
quick_access.xml
xpathtoolbar.xml
xslttoolbar.xml

align_object.xml
fmtoolbar.xml
fmtoolbar_review.xml
graphics.xml
object_properties.xml
para_format.xml
quick_access.xml
quick_access_review.
xml
structured.xml
table_format.xml
tag-description.xml
text_format.xml
trackchanges.xml

align_object.xml
fmtoolbar.xml
fmtoolbar_review.xml
graphics.xml
object_properties.xml
para_format.xml
quick_access.xml
quick_access_review.
xml
structured.xml
table_format.xml
tag-description.xml
text_format.xml
trackchanges.xml

Customisation $HOME\ fminit\configue\cusomui.cfg
This file contains both menu defintions and (hypertext) command defintions.

a. Commands are located in fminit\configui\interface\view\
b. Work spaces are located in fminit\WorkSpaces\interface\view\

c. none.fws is an empty workspace used if no document or book is open. It can be used to build a custom work 
space from scratch. It can refer to a custom menu, but does not honour the definition of a custom toolbar 
set — IMHO this is an error.

d. The purpose of menus named menus_ts.cfg is IMHO unclear.

e. fmtoolbar.xml does not define commands and icons for a tool bar, but lists all the tool bars available in this 
work space.
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Relationship between the UI files

example_tb.xml

SkinGallery
Startup
WorkSpace
…
tb-icon_C_L.png
tb-icon_C_S.png
tb-icon_M_L.png
tb-icon_M_S.png
tb-icon_R_C_L.png
tb-icon_R_C_S.png
tb-icon_R_M_L.png
tb-icon_R_M_S.png
…
maker.ini
…

%appdata%\Adobe\FrameMaker\13

Structured
UnStructured
XMLAuthor

AuthorView
CodeView
FormView
WYSIWYGView

menus
toolbars
Authoring.fws
Blank.fws
Custom.fws
Design.fws
Manage Graphics.fws
none.fws
Review.fws
Structured Auth.fws

align_object.xml
custom_toolset.xml
direction.xml
example-tb.xml
fmtoolbar.xml
fmtoolbar_review…
graphics.xml
object_properties…
para_format.xml
quick_access.xml
quick_access_rev…
quick_element.xml
structured.xml
table_format.xml
tag-description.xml
text_format.xml
trackchanges.xml

menus.cfg
custom_menus.cfg
menus_review.cfg
menus_struc-
tured_authoring.cfg
menus_ts.cfg

SkinGallery
Startup
WorkSpaces
…
tb-icon_C_L.png
tb-icon_C_S.png
tb-icon_M_L.png
tb-icon_M_S.png
tb-icon_R_C_L.png
tb-icon_R_C_S.png
tb-icon_R_M_L.png
tb-icon_R_M_S.png
…
maker.ini
…

For documentation on this file, see "Customizing Frame Products" Online Manual

MS Windows FrameMaker Menu Configurations

*** Document Window Main Menu ***

<ReservedMenu !MakerMainMenu<Label Adobe FrameMaker>>
   <Menu FileMenu      <Label File>>
   <Menu EditMenu      <Label Edit>>
…
[etb  Addenda]====================================================
*** The [label] constructs provide file navigation in EditPad
    File is harmonised with all the other etb-customui.cfg files
*** Remarks
    - This file (customui.cfg) can not be UTF-8, it must be in Windows CP 1252
      using FrameRoman coding for Label statements.
…
[etb Documentation]
<Command ETBfmConsole  <Label Console Log File>
  <Hypertext message openfile H:/Adobe/…/fminit/configui/etb-GetLogFile.exe>>
…
[etb Menu]
<Add ETBmenu <Menu !HelpMenu>>
<Order !HelpMenu.ETBmenu <Before !HelpMenu.AdobeOnlineSupport>>
<Add ETBfmConsole                       <Menu ETBmenu>>
…

<?xml version="1.0" encoding="UTF-8"?>
<FMTOOLBARLIST version="1">

<TOOLBAR file="graphics.xml"/>
<SEPARATOR sep_id="0"/>
<TOOLBAR file="quick_access.xml"/>
<TOOLBAR file="structured.xml"/>
<SEPARATOR sep_id="1"/>

…
<TOOLBAR file="example-tb.xml"/>

</FMTOOLBARLIST>

custom_toolset.xml
<?xml version="1.0" encoding="UTF-8"?>
<FMTOOLBARLIST version="1">
  <TOOLBAR id="custom_tb" name="Custom Toolbar" kbd-shortcut="\!Vzz"
    orientation="horizontal" readOnDocChange="true">
<!-- Standard commands -->
    <ACTION command="RepeatLastParaCommand" tooltip="Repeat…]">
      <images base="tb-icon" />
    </ACTION>
...
    <DROPDOWN command="!RulerParaMenu" tooltip="Paragraph …"/>
    <FLYOUT command="!RulerAlignMenu" tooltip="Text alignment">
      <images base="P_TextAlignLeft_Md" />
     </FLYOUT>
...
  </TOOLBAR>
</FMTOOLBARLIST>

custom_menus.cfg
For documentation on this file, see "Customizing Frame Products" Online Manual

MS Windows FrameMaker Menu Configurations

*** Document Window Main Menu ***

<ReservedMenu !MakerMainMenu<Label Adobe FrameMaker>>
   <Menu FileMenu      <Label File>>
   <Menu EditMenu      <Label Edit>>
…
[Customisation] ==================================================
*** Example menu customisation
*** KLD 2016-01-18

*** Place a new menu item after the first one in the Help menu

*** Define a new command with a name not yet kwnown to FM
<Command CustomOfflinePDF     <Label Local User guide (PDF)>
  <Hypertext message openfile H:/Adobe/AdobeFrameMaker12/fminit/configui/
FM12-help.pdf>>

*** Define menu entry with the command
<Add CustomOfflinePDF         <Menu !HelpMenu>>

*** Place the menu item to the desired place
<Order !HelpMenu.CustomOfflinePDF     <After !HelpMenu.Help>>

<FrameUI version="1">
  <data type="all" menuFile="custom_menu.cfg" toolbarFile="custom_toolset.xml"/>
  <fm-workspace>
    <workspace version="1">
      <dock anchor="top" content="multi-control-bar" is-closed="false">
…
      </dock>
      <control-bar id="00070CEA" origin="-16 -2" size="558 26" is-closed="true" 
        app-data="#lt;control-bar cb-data=#quot;custom_tb#quot; 
          minimum-size=#quot;454 26#quot; maximum-size=#quot;1868 26#quot; 
          preferred-size=#quot;558 26#quot;/>"/>
    </workspace>
  </fm-workspace>
</FrameUI>

Custom.fws

same as customui.cfg

original menu contents
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Menus
customui.cfg For FM versions prior to FM-11 all customisation was estab-

lished in the file fminit\configui\customui.cfg.

The possibilities in this file are explained extensively in the 
Adobe document Customisation of Frame Products (FM-7).

This file is still required if the menu modifications are to be 
visible from the beginning.4)

However, the contents of this file must also be appended to 
the relevant menu file. It is good practice to copy a menu file 
to a new file, e.g. custom-menu.cfg and then append the con-
tents of customui.cfg to it.

Views Since FM-11 the contents of menus depend on a view. Hence 
there are several menu files. See Files for the UI on page 9. As 
an example the WYSIWYG view of the unstructured interface 
of FM-12/13 is listed:

$HOME\fminit\configui\
cmds.cfg
sample.cfg
UnStructured\

WYSIWYGView
mathcmds.cfg
wincmds.cfg

$HOME\fminit\WorkSpaces
UnStructured

WYSIWYGView\
Authoring.fws
Blank.fws
Design.fws
Manage Graphics.fws
Review.fws
menus\

menus.cfg
menus_review.cfg

toolbars\
align_object.xml
fmtoolbar.xml
fmtoolbar_review.xml
graphics.xml
object_properties.xml
para_format.xml
quick_access.xml
quick_access_review.xml
structured.xml
table_format.xml
tag-description.xml
text_format.xml
trackchanges.xml

4 customui.cfg in FM-12 and later is only relevant before a workspace is se-
lected - that is, before any book or documents have been opened. AFter 
closing all documents or books no customisation is active.
none.fws is an empty workspace. It can be used to build a custom work 
space from scratch. It can refer to a custom menu, but does not honour 
the definition of a custom toolbar set — IMHO this is an error.
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Customising menus

Customisation To create your custom menu, take the appropriate standard 
menu and copy it to a new file. Name this file with a prefix of 
your customisation project. For example custom-menus.cfg.

You develop the customisation in a file customui.cfg which is 
located in $HOME\fminit\configui\. As long as you have not a 
customised menu assigned to a workspace, the menu custo-
misation is only visible during the display of the splash 
screen (before you have opened a document or book).

To be available regularly the contents of customui.cfg must 
also be appended to a menu file, which is referenced in the 
workspace (see Relationship between the UI files on page 10).

To be available also with no document or book open, work-
space $HOME\fminit\WorkSpaces\UnStructured\none.cws must 
point to the modified menu file (see table footnote c on page 
9):

<FrameUI version="1">
<data type="all" menuFile="custom-menus.cfg" toolbarFile="fmtoolbar.xml"/>
<fm-workspace>

Testing menus You do not need to restart FM to test a modified menu. With 
View > Menus > Modify… it can be read into the current 
workspace.

Errors in the customisation file are reported in the FM console 
window. Even if an error is found, reading and interpreting 
the file continues.

Commands in menus In the various existing menus you can find a desired com-
mand for your special menu entry. You may however need to 
set up a new command:

 See Hypertext commands on page 36.

 See Command names from plugins and scripts on page 41

Open a file Hypertext message openfile H:/Adobe/AdobeFrameMaker12/fminit/
configui/FM12-help.pdf

Execute a program <Command ETBfmConsole <Label Console Log File>
<Hypertext message openfile H:/Adobe/AdobeFrameMaker12/

fminit/configui/GetLogFile.exe>>

Hyper-links with relative paths always point to files in the 
same directory as the parent file. While for documents this 
can be interpreted, it is not clear what it means for menus.

Relative paths do not start in $HOME as in pre-FM9. They start 
in the current document folder: $path[initdir]/fminit does 
not work (neither upper/lower/mixed case, nor with path in 
quotes or double quotes).

For addressing scripts see Note concerning scripts on page 25.

Execute a FrameScript <Add iFrameMultiCatalog <Menu FormatMenu>>

Execute an ExtendScript <Add ImportFormatsSpecial <Menu FormatMenu>>
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Menu customisation, example 1

Task You are tired of searching for the offline user guide (pdf). 
Once you have downloaded it via Help > Help Topics > 
Getting Started > General Resources. You placed it in 
$HOME\fminit\configui\ with the name FM-12-help.pdf.

You want to open this file with Help > User Guide PDF. 

Note: This example establishes a customisation only for the unstruc-
tured interface in the WYSIWYGView:

 Create/update customui.cfg in $HOME\fminit\configui\.

 Modify the relevant menu in 
%appdata%\Adobe\FrameMaker\vv\ (vv is 12 or 13).

customui.cfg In a plain vanilla FM installation this file does not exist. Hence 
you need to create it. This file must be in Windows code page 
(cp 1252), not in UTF-85)!

«-- Example menu customisation [KLD 2017-04-07] 6)

<Command CustomOfflinePDF> «-- Define a new command (name not yet kwnown to FM)
<Label Local User guide (PDF)>
<Hypertext message openfile H:/Adobe/AdobeFrameMaker12/fminit/configui/FM12-help.pdf>>

<Add CustomOfflinePDF <Menu !HelpMenu>> «-- Define menu entry with the command

<Order !HelpMenu.CustomOfflinePDF «-- Place the menu item to the desired place
<After !HelpMenu.Help>>

Note: For test purposes you may reference any pdf file in the com-
mand. Adjust the file location - use forward slash (/) in place of 
backslash (\). Only absolute paths work!

Modify the relevant menu The customisation by customui.cfg is only active when no 
document or book is open. Hence we need to do more:

 The menu to be modified is 
%appdata%\Adobe\FrameMaker\vv\WorkSpaces\UnStructured\W
YSIWYGView\menus\menus.cfg.

 Create a backup of the original menu file: menus_ori.cfg.

 Append the contents of customui.cfg to the relevant menu 
of the workspace to be available for open documents or 
books.

After starting FM and selecting the WYSIWYG view, the menu 
modification is active.

5 The file coding is not at all consistent:
cp 1252: *.cfg (customui.cfg, cmd.cfg, mathcmd.cfg, menu.cfg etc.)
UTF_8:  *.xml (toolbars), *.fws, *.cfws (work space), maker.ini.

6 Relevant information starts with < and ends with >. This may be nested. 
Hence there is no special notation for comments. I use the guillemets.
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Menu customisation, example 2

Task You want to have a context menu for inserting special charac-
ters. The existing flyout is not touched.

Note: This example establishes a customisation only for the unstruc-
tured interface in the WYSIWYGView:

 Create/update customui.cfg in $HOME\fminit\configui\.

 Modify the relevant menu in 
%appdata%\Adobe\FrameMaker\vv\ (vv is 12 or 13).

customui.cfg In a plain vanilla FM installation this file does not exist. Hence 
you need to create it. This file must be in Windows code page 
(cp 1252), not in UTF-87)!

«-- SpecialChars Context menu [KLD 2017-04-07]
<Menu SpecialCharsContext «-- define a new context menu

<Label Insert Special Character >>

<Command MyCharEllipsis «-- for each entry you specify these parameters:
<Definition \xC9>
<Label \xc9   &ellipsis> «-- the menu label starts with symbol
<KeySeqLabel \e> >

<Add MyCharEllipsis <Menu SpecialCharsContext>>                            

<Command MyCharOneQuarter «-- another symbol to be in my list 8)
<Definition \xB9>
<Label \xb9   quarter &1>
<KeySeqLabel \\xb9> >     

<Add MyCharOneQuarter <Menu SpecialCharsContext>>
«-- Add the new menu to various contexts:

<Add SpecialCharsContext <Menu !TextContextMenu>>
<Order !TextContextMenu.SpecialCharsContext <Before !TextContextMenu.Undo>>

<Add SpecialCharsContext <Menu !TableTextContextMenu>>
<Order !TableTextContextMenu.SpecialCharsContext <Before !TableTextContextMenu.Undo>>

<Add SpecialCharsContext <Menu !TextLineContextMenu>>
<Order !TextLineContextMenu.SpecialCharsContext <Before !TextLineContextMenu.Undo>>

It currently not known how to define symbols which are not 
the FrameRoman code page (arbitrary Unicode symbols).

Modify the relevant menu The customisation by customui.cfg is only active when no 
document or book is open. Hence we need to do more:

 The menu to be modified is 
%appdata%\Adobe\FrameMaker\vv\WorkSpaces\UnStructured\W
YSIWYGView\menus\menus.cfg.

 Create a backup of the original menu file: menus_ori.cfg.

 Append the contents of customui.cfg to the relevant menu 
of the workspace to be available for open documents or 
books.

After starting FM and selecting the WYSIWYG view, the menu 
modification is active.

7 The file coding is not at all consistent:
cp 1252: *.cfg (customui.cfg, cmd.cfg, mathcmd.cfg, menu.cfg etc.)
UTF_8:  *.xml (toolbars), *.fws, *.cfws (work space), maker.ini.

8 Command names must not contain figures (My1Quarter is invalid).
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Toolbars

Customising Toolbars

Customising toolbars or creating new toolbars is more elabo-
rate then customising menus, because more files are involved 
(See Relationship between the UI files on page 10):

 The toolbar file itself (e.g. custom-tb.xml).

 The list of toolbars in fmtoolbars.xml.

 The icons needed for the toolbar.

 You may also have the need to implement scripts.

 You may save the modified workspace with a new name.

Note: Toolbars containing a drop-down list can not be docked at left 
or at right to become vertically oriented!

Toolbar commands When setting up a toolbar you need to have an idea which 
commands to use. Get the exact names from the appropriate 
menus (see Commands on page 19) or from a command list. 
See for example www.daube.ch.

For more details see Commands on page 29.

There are some not so well known things about commands. 
Hence see also Some particularities of commands on page 36.

Using ExtendScripts in a toolbar can be done in two ways:

 The script defines its command name internally. See the 
red names in File simple.jsx on page 17. Such scripts can be 
compiled to jsxbin for hiding its innards.

 An ExtendScript can also be invoked by a hypertext com-
mand. In this case the script must reside in 
%userprofile%\Documents\Adobe Scripts\ and it can only by 
of file type jsx9):

<Command ETBnudge <Label Nudge object info>
<Hypertext message openfile C:/Users/Klaus/Documents/Adobe 

Scripts/ETBnudge.jsx>>

Example toolbar

Task The following is an example toolbar with all types of widgets. 
We will add it to the common toolbar list.
 

This tool bar shall be available in the unstructured interface, 
in the WYSIWYG View.

9 An xxx.jsxbin file would just be opened in Notepad and of course pre-
sents gibberish.

Invoke ExtendScript
Invoke FrameScript

Command
Drop-down list

Command

http://www.daube.ch/docu/fmaker00.html#specialdoc


Customising FrameMaker 12/13

24 – 16

You can find all files for this example toolbar on my website.

Note: If not specially noted, the file locations start with 
%appdata%\Adobe\FrameMaker\vv\ with vv being 12 or 13.

Create the example tool 
bar

The following steps are required:

 Create file 
…\Workspaces\UnStructured\WYSIWYGView\toolbars\example-
toolbar.xml defining the buttons and their commands as 
well as keyboard-short cuts. See File example-tb.xml on 
page 16.

 Save a copy of 
…\Workspaces\UnStructured\WYSIWYGView\toolbars\fmtoolba
r.xml as fmtoolbar-ori.xml before inserting the following 
just before the last line:

<SEPARATOR sep_id="5"/>
<TOOLBAR file="example_tb.xml"/>

 Save the FrameScript file primitive.fsl to any location you 
want, for example to $HOME\fminit\configui\

 Save the ExtendScript simple.jsx to …\StartuUp\
 Since we need custom icons, you can create them according 

to Toolbar icons on page 26. You can find three icons for 
this example toolbar 

 After start of FrameMaker select the WYSIWYG View, for 
which we have set up the two files custom_toolset.xml and 
example_tb.xml.

In menu View > Toolbars you will find the new toolbar and 
can activate it.

Integrating toolbar into 
workspace

The toolbar will appear in menu View > Toolbars. There you 
activate it and it will initially float around.

The workspace mechanism has assumed a certain width of 
the toolbar which can be adjusted with the lower resize han-
dle:

As usual the toolbar is docked to the other toolbars with the 
docking handle.

You can now save the current workspace, with or without a 
different name.

File example-tb.xml This file describes the contents of the toolbar. This example 
references standard commands as well as a FrameScript and 
an ExtendScript.

<?xml version="1.0" encoding="UTF-8"?>
<FMTOOLBARLIST version="1">

<TOOLBAR id="custom_tb" name="Custom Toolbar" kbd-shortcut="\!Vzz" 
 orientation="horizontal">

<!-- Standard command -->
<ACTION command="RepeatLastParaCommand" tooltip="Repeat last ¶ command [Esc j j]">

<images base="etb-para-repeat" />
</ACTION>

<!-- Drop-down list -->

Docking handle

Resize handle

http://www.daube.ch/docu/files/FM-customisation-example.zip
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<DROPDOWN command="!RulerParaMenu" tooltip="Paragraph formats"/>
<!-- Fly-out menue -->

<FLYOUT command="!RulerAlignMenu" tooltip="Text alignment">
<images base="P_TextAlignLeft_Md" />

</FLYOUT>
<!-- simple FrameScript -->

<ACTION command="MyCommand1" tooltip="This FrameScript just provides a message">
<images base="tst-fs" />

</ACTION>
<!-- simple ExtendScript -->

<ACTION command="msgJS" tooltip="This ExtendScript just provides a message">
<images base="tst-estk" />

</ACTION>
</TOOLBAR>

</FMTOOLBARLIST>

The ID of the toolbar need not be the same as the file name. I 
choose custom_tb for the ID, although the file names is 
example_tb.xml. The ID is used in the workspace files only.

For each tool button a type is defined:

ACTION Button for standard command.

DROPDOWN Open a drop down list of commands.

FLYOUT Open a sub menu of commands.

See Tags in toolbar files on page 22 for more details.

File simple.jsx This ExtendScript shall be placed into …\Startup\

// simple.jsx
#target framemaker  

var msg1 = "JavaScript alert message\nYou always get an information icon"
var msg2 = "FrameMaker Alert dialogue\nIcon/Buttons depend on second parameter"

// set up menu with just two items
var mMenu = app.GetNamedMenu("!MakerMainMenu");
var simpleMenu = mMenu.DefineAndAddMenu("Simple", "Alerts");
simpleMenu.DefineAndAddCommand(1,"msgJS","JS alert","");
simpleMenu.DefineAndAddCommand(2,"msgFM","FM Alert","");
UpdateMenus();

// watch the suptle difference in syntax: alert | Alert
function Command(cmd){
  switch(cmd) {
    case 1:
      alert (msg1, "Message title");
      break;
    case 2:
      Alert(msg2, Constants.FF_ALERT_CONTINUE_NOTE);
      break;
  }
}

File primitive.fsl This FrameScript can be placed wherever you want, for exam-
ple to $HOME\fminit\configui\ 

In FrameScript this script must be installed to start with FM. 
Only after the next start of FM the function will be available.

// A primitive Event FrameScript: just some messages
// [2016 Klaus Müller, itl]
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// An event script is necessary if a static command name is required,
//   e.g. to be used in a tool bar or menu (and be distributable)
//   Ordinary FrameScripts get generic command names which my be 
//   different at each start and are hence not distributable
// Event FrameScripts must be installed, not just run
//
// In an EventScript commands must reside within Events
// Menus and commands are defined within the Event Initialize
// It is good practice to remove the menu with Event Terminate
// A menu item is not necessary, for example if the command is used in a toolbar

// --- Set up a command name and the event trigger
Event Initialize
// Get Object Type(Menu) Name('!MakerMainMenu') NewVar(gvMainMenu);
// New Menu Label('My Menu') NewVar(gvMyMenu) AddTo(gvMainMenu);
  New Command Name('MyCommand1') Label('My Command 1') 

EventProc(evtCmdEvent) NewVar(gvMyCmd1)  // AddTo(gvMyMenu) 
EnabledWhen(EnableAlwaysEnable) 

EndEvent

// --- Remove command and menu at de-installtion time
Event Terminate
// Remove CommandObject(gvMyCmd1) From(gvMyMenu);
// Remove MenuObject(gvMyMenu) From(gvMainMenu);
EndEvent // Terminate

// --- The event procedure is the real task
Event evtCmdEvent
If ActiveDoc = 0
  MsgBox 'No active document --- Nevertheless: Welcome to the club.';
Else 
  MsgBox 'We have a document open --- Eventhough: Welcome to the club.';
EndIf
EndEvent // evtCmdEvent
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Configuration files
Configuration files define both commands and menus. These 
files still have the format as in previous FM versions. That is, 
they are named xxx.cfg and use the well-known MIF syntax 
(not xml).

The names of these configuration files are specified in the ini-
tialisation file for FrameMaker (see [Files] in maker.ini).

customui.cfg The file fminit\configui\customui.cfg is a special configura-
tion file called customisation file, because with this file com-
mands and menus are customised.

If this file does not exist or does not have the name defined in 
maker.ini (see [Files] in maker.ini) then no customisation is 
performed.

Commands The commands are defined in three files located in 
$HOME\fminit\configui:

With the introduction of views, multiple files cmds and 
wincmds. exist.

Menus Until FM-10 menus were located in $HOME\fminit\maker. FM-11 
introduced the concept of views which requires a multitude 
of menus. See Relationship between the UI files on page 10.

Note: While standard menus are in their own files (separated from 
commands) the customisation file customui.cfg may contain 
both commands and menus. Also a custom menu may contain 
both kinds of definitions.

Configuration file 
statements

A configuration file consists of a series of statements that 
define menus, menu items, and the order of those items. 
Commands are also defined in configuration files and may 
contain definitions for details which may also be present in 
menu files.

Properties of statements  Statements are case-sensitive.

 Each statement is enclosed in angle brackets (< and >).

 Statements must appear in a particular order.

 A statement begins with a keyword defining its function.

 A statement may span several lines.

 Text outside angle bracket-pairs is treated as comment. 
Don’t include angle brackets in comments. Hence if you 
want to comment out statements, you need to replace the < 
> symbols, for example, by { }.

comment examples [etb --- ETB addenda] ======================================
*** The [label] supports file navigation in EditPad

- This file (customui.cfg) can not be UTF-8, it must
use Windows encoding and FrameRoman coding for Labels

- Defaulit path ($HOME) is named here  + fm-root+
(no blank after first +). This is exchanged by the
installation pgm with the real $HOME directory.

File Contents

cmds.cfg General commands, Escape sequences

mathcmds.cfg Commands for the Equation Editor

wincmds.cfg Platform dependent commands, definition of shortcuts

http://www.daube.ch/docu/fmaker65.html#files
http://www.daube.ch/docu/fmaker68.html#files
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Initialisation sequence When FrameMaker starts, it first reads the standard menu and 
command configuration files and then a customisation file10). 
The information in each file overrides the information in files 
read previously. Hence the following order is necessary:

1 Definition of the commands.

2 Modification of labels, shortcuts.

3 Definition of a menu item referring to a command.

4 Order of the menu item or sub menu within parent menu.

Statements in configuration files

10 This process is called Localisation in the progress indication during the 
start. This is due to the fact that the menu files are different for each UI 
language. In FM the UI language is defined at installation - it can not be 
changed afterwards.

Purpose Statement, statement detail

Define a command Command on page 30

Define a command for a menu item that 
is chosen while the Shift key is held down

ShiftCommand on page 30

Define a new label for a command or 
menu item

Modify on page 31

Define the function to be called when a 
command is chosen

Definition on page 32

Define a label for a menu or command 
that is visible in the user interface

Label on page 32

Define a context-sensitive label for a 
menu or menu item.

ReservedLabel on page 32

Define a keyboard shortcut for a com-
mand

KeySequence on page 33

Define a label for the shortcut which ap-
pears next to the command name on the 
menu

KeySequenceLabel on page 34

Define whether a command is a general 
command, a FrameMath command (for 
the Equation Editor), or both

Mode on page 35

Define an Asian typography command AsianFonts on page 35

Define a new menu Menu on page 44

Define a new reserved menu Reserved menu on page 44

Add a menu item to a menu Add on page 45

Define a particular place for a menu item 
on a menu.

Order on page 46

Remove a menu or menu item Remove on page 30
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Debugging customisation files

If you’re writing a lengthy menu customisation file, consider 
writing and testing the customisations a few at a time. This 
will make it much easier to locate problems in the statements 
you write. As you create the file, you can save the file and 
then read it into FrameMaker to test your statements.

With View > Menu > Modify… the modified menu can be 
read.

To display error messages when you load a menu customisa-
tion file, set ShowErrors in maker.ini to On. You can also turn 
On the keyboard shortcut alerts (ConfigWarnKbdOverride, 
ConfigWarnKbdOverride) to see error messages in the console 
window11). If you find errors, you can fix them immediately 
and continue writing.

When you read the same menu customisation file again12), 
you’ll see error messages about redefining a command 
(because the same statements are being read again). Ignore 
these messages. Use comments throughout the menu custo-
misation file to document your work. Others may need to edit 
the file later.

11 Please note that even a plain vanilla FrameMaker installation will create 
a huge number of such messages, because definitions are ‘overloaded’. It 
may be difficult to find real errors this way …

12 I’m not certain whether this method with View > Menus > Modify… 
works reliably in FM-11 and beyond. We have now at least two modifica-
tion files…
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Tags in toolbar files
Note: Be aware that in strings (e.g. defining the tool tip) no & must 

be used. Character entities (e.g. #amp;) are not resolved. Use 
the word ‘and’ or the ‘+’ sign in place of the ‘&’.

First line of toolbar file <?xml version="1.0" encoding="UTF-8"?>

Comments Comments are in the standard XML/HTML format:

<!-- One line comment -->
<!-- Multiline comment

intermediate line
last line -->

Note: XML comments must not appear before the FMTOOLBARLIST 
statement!

Example See File example-tb.xml on page 16. It displays most of the fol-
lowing tags.

FMTOOLBARLIST This is the root tag in a toolbar file.

Syntax <FMTOOLBARLIST attributes />
TOOLBAR statement with details

</FMTOOLBARLIST>

Attributes version="1" Parser version for which this toolbar file was 
written. Value needs to be compatible with the cur-
rent parser version.

TOOLBAR This tag defines the toolbar and is a wrapper for the items on 
the toolbar.

Syntax <TOOLBAR attributes />
tool tags (ACTION, DROPDOWN, …)

</TOOLBAR>

Attributes file File name of the toolbar, if the description is to be 
picked from somewhere else. If this attribute exists 
no other attributes are parsed here.
This attribute is not present in any of the Adobe 
toolbars up to FM-13.

id Unique identifier for the toolbar, for workspace 
identification, FDK access and API notifications 

name Name of the toolbar as visible in the menu. 
This may contain character entities, for example 
name = "Paragraphs #amp; Characters"

orientation Keyword defining the default orientation of the 
toolbar:

horizontal: Default orientation is horizontal. 

vertical-narrow: Default orientation is vertical and 
the items are arranged in a single col-
umn.

vertical-wide: Default orientation is vertical and 
the items are arranged in two col-
umns.

dock Keyword defining the preferred/default dock (cur-
rently horizontal toolbars can be docked only at 
the top):
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left: Toolbar will be docked at the left 
anchor

right: Toolbar will be docked at the left 
anchor

top: Toolbar will be docked at the top 
anchor

none: Toolbar will be floating

kbd-shortcut Key-sequence to activate the toolbar (default = 
none)

readOnDocChange I have no idea, what this is good for. Found 
only in quick_element.xm.

Tool tags

ACTION The action tag defines the command assigned to an UI button.

Syntax <ACTION attribute/>
<IMAGES ...>

</ACTION>

Attributes command Identifier of an already defined FM action - a 
required attribute.

name Name of the action (default is the tag defined for 
the command) 

tooltip Tool tip displayed on mouse hover (default is the 
name of the action)

help Help String for the action command (default= none)

image An image-name for the action (default= None) 13).

TOGGLE A toggle tag is used to define two (logically alternating) 
actions to be performed from a single widget.

Note: I have not managed to get this working. I have also not seen 
this tag in any Adobe tool bar yet.

Syntax <TOGGLE attributes1 />
<command attributes2 />

</TOGGLE>

Attributes1 name Name of the toggle (default= None)

tooltip Tool-tip that is displayed on mouse hover (default= 
name of the toggle)

help Help String for the toggle command (default= 
None)

image An image-name for the toggle (default= None) 13). 

Attributes2 on Required identifier of an already defined FM action 
(non-toggle type).

off Required identifier of an already defined FM action 
(non-toggle type).

13 This tag attribute may be replaced by images = list of images (see 
IMAGES on page 24)
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FLYOUT This is used to define a popup menu.

Syntax <FLYOUT attributes />

Attributes command Identifier of an already defined FM Menu - a 
required attribute.

name=" Name of the flyout (default= the tag defined for the 
command)

tooltip Tool tip that is displayed on mouse hover (default= 
name of the flyout)

help Help string for the flyout command (default= none)

image An image-name for the flyout (default= none) 13). 

DROPDOWN This is used to (generally) define a menu whose sub items are 
a list of options that can be chosen one at a time, for example, 
fonts.

Syntax <DROPDOWN attributes />

Attributes command Identifier of an already defined FM Menu - required 
field"

tooltip Tool tip that is displayed on mouse hover (default= 
name of the drop-down)

help Help String for the drop-down command (default= 
none)

Note: There is no width indication for this widget. The width is 
assumed by the workspace mechanism. If more than one drop-
down list appears in a tool bar then resizing ins applied to all 
proportionally.

SEPARATOR This tag places a separator between two items

<SEPARATOR/>

Detail tag

Detail tags are optional. Currently only the IMAGE tag is in this 
category.

IMAGES This tag describes the images displayed on an ACTION, FLY-
OUT and TOGGLE. Alternatively only one image can be 
defined (see ACTION on page 23).

Syntax <images attributes />

Attributes normal Default image displayed when the UI is 
bright (default= none)

rollover Image displayed on mouse hover when the 
UI is bright (default= normal image)

dark_normal Default image displayed when the UI is 
dark (default= normal image)

dark_rollover Image displayed on mouse hover when the 
UI is dark (default= dark_normal image)

Example See Using icon-images on page 26.
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Toolbar commands

See also section Commands on page 29.

All the menu items/commands that end up executing an FCode 
can be used here. Hence hypertext commands can not be 
used. However, scripts (FrameScript, ExtendScript) can be ref-
erenced. See Example toolbar on page 15.

Note concerning scripts  Scripts must be loaded during the start of FrameMaker. 
This action generates a command name and an FCode for 
the script.

 The FCode assigned to a script may differ from FM session 
to FM session. Hence it is useless.

 ExtendScripts are located in 
%appdata%\Adobe\FrameMaker\vv\Startup\ 
The name of the script name (without the file extension) 
provides the command name. Installed ExtendScripts get 
command names from their internal command definitions.

 FramExtendScripts may be located anywhere. However it 
must be assured that they are loaded at start of 
FrameMaker. See FrameScript options.

 The name for the command may not be identical to the 
script file name (excluding the file extension) due to an ini-
tial script. You may get the proper command name by the 
free FrameScript Report FM Commands from itl.

For details see Command names from plugins and scripts on 
page 41.

File name of script Command name

ImportFormatsSpecial.jsx ImportFormatsSpecial
MultiCatalog.fso iFrameMultiCatalog
RemoveUnusedFormats.fsl ESLSSRUN305 a

a. This is an automatically generated command name.

http://www.i-frame.itl.info/en/feature-description/free-scripts/report-fm-commands.html
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Toolbar icons

Standard icons Icons for toolbars and for the dialogues are located in 
resource files: fmcustom.dll, fmres.dll, owlres.dll. fmdlg.dll 
and are not relevant in this context.

Names of such icons can be deducted from existing tool bars 
or from my web site (look for “tool bar resources”).

Custom icons If images are needed, which are not in these resources, they 
must be of type png (Portable Network Graphic) and be 
located in the user-area (in the same directory as maker.ini).

Hovered (roll over) icons are framed. When clicked the icon it 
gets a darker background. Hence the icons must be transpar-
ent.

Large and coloured icons Since FM-12 both large and/or coloured icons are supported. 
Regular sized icons are 18×18 pixels, large icons are 26×26 
pixels. Hence the maximum number of icon images is 8.

You can have 8 image files for the following possible combi-
nations of preferences with base name e.g. xyz:

In most cases the R_X_X forms are copies of the _X_X forms.

Using icon-images 1 Add the base name of the icon in the base attribute of the 
image element.

<ACTION command="RepeatLastParaCommand"
tooltip="Repeat last ¶ command [F4]">

<images base="etb-para-repeat" />
</ACTION>

2 Create at least 2 icon images for normal and rollover state 
of the icon. For example if the icon name is xyz the image 
names will be xyz_C_S.png and xyz_R_C_S.png. (Here, C= col-
our, S=regular, and R=rollover.) If, however, your icon pref-
erences are set to have large or greyscale icons instead of 
regular and colour, you will use M and L in the icon names.

3 You can further add more icon files for icon states, such as 
dark_normal and dark_rollover by specifying attributes 
with data in the relevant element. For example:

<ACTION command="CenterPara">
<images base="P_TextAlignCenter_Md"

dark_normal=”<icon_name>.png” <!-- regular size -->
dark_rollover=”<icon_name>.png”
dark_normal_l=”<icon_name>.png”<!-- large size -->
dark_rollover_l=”<icon_name>.png”    

/>
/>

Preferences Icon names

Size Colour Normal Rollover

Size Colour Normal Roll over

Large (L) Coloured (C) xyz_C_L.png xyz_R_C_L.png

Greyscale (M) xyz_M_L.png xyz_R_M_L.png

Regular (S) Coloured xyz_C_S.png xyz_R_C_S.png

Greyscale (M) xyz_M_S.png xyz_R_M_S.png

http://www.daube.ch/docu/fmaker00.html#internals
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Example icons These are all from fmcustom.dll, base name = P_AddRows

 Although there are special images for the roll-over situa-
tion, the pictures are the same (_C_S = R_C_S).

 In roll-over state the buttons are surrounded by a border 
and the background becomes lighter than in normal state. 
Hence there is no need for special images.

Default icons The result of missing images depend on the ‘severity’ of the 
problem:

If size does not fit, the defaults are boxes with text in them:

If set to regular size, standard icons not found are depicted 
with a default icon:

Tool bar icons and 
workspaces

 A workspace defines the toolbars to be active in it.

 References to all sorts of icons (small/large, grey/coloured) 
exist in the tool bar.

 The size and colour of icon to be displayed is only defined 
in Preferences > Global > Interface > Icons.

If you do not see coloured icons after switching to a work-
space which should have them, check your settings in 
Preferences. After changing these preferences a restart of 
FrameMaker is required.

Contents of the resource 
files in fminit

With the new UI two additional resource files were intro-
duced: owlres.dll and owlres.res. These contain png images 
which are not handled by (to me) known resource editors. 
Also fmcustom.dll now contains png images, no more bit maps 
(bmp).

S - Regular (18 × 18) L - Large (26 × 26)

C - Coloured M - Grey C - Coloured M - Grey

Normal Roll over Normal Roll over Normal Roll over Normal Roll over

_C_S _R_C_S _M_S _R_M_S _C_L _R_C_L _M_L _R_M_L

File Icons, pictures Dialogues Other

fmcustom.dll Images for toolbar also icons for the panels 
and graphic toolbar. 2 to 8 variants per image.

none version info

fmdlg.dll Rubi-bit maps [bmp]. Many new items (panels) classic dialogues, panels, 
panel-lists

Icongroup (icons for the dia-
logues) version info; 500 (?)

fmres.dll Button images for dialogues, palettes and pan-
els (16x16), [bmp]. Some items no more used

none Cursor group (32x32 cursors); 
Icongroup (icons in panels etc.)

owlres.dll Images for the new toolbars [png]. 2 to 4 vari-
ants per image. This file is new with FM-9

C-like definitions for appli-
cation bara, grafix bar, UI 
preference dialogue etc.

Xstr (strings with all text in xml 
notation); version info (correct)

a. This relate to functions to the right of the menu bar (UI visibility, Arrange documents, Screen mode) 
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Extract icons

To get the icons out of the DLLs – to have individual files to 
work on for the tool bar buttons – my procedure is the follow-
ing:

Extract and rename 1 Open the dll in ResHacker.

- Select the appropriate resource type (e.g. bitmap).

- Save the resources with Action > Save [...] resources.

- Use an rc name such as fmres-bmp.rc .

2 Open the rc file in EditPad.

- Convert double to single line spacing

- Use the REGEX to exchange the 'columns':

fmcustom binaries     (.+) png "(.+)"            \2\t\1

fmres bitmaps      (.+) bitmap "(.+)"         \2\t\1
cursors      (.+) cursor "(.+)"         \2\t\1
icons        (.+) icon "(.+)"           \2\t\1

owlres binaries     (.+) png "(.+)"            \2\t\1
- Remove blanks at start of line

- Save the table as fmres-rename-table-bmp.txt

3 Start RenameByTable.ahk

- Attention: the table file must be in Windows code page, 
not UTF.

- Fill in all fields, including the target file extension.

PDF of all icons 1 Open the directory (e.g. E:\FM-specials\FM-12-
tests\Resources-owlres\renamed-png) in Thumbs+.

2 In Image > Print Catalog set up a layout (or use icon-
overview) with the following properties:

- Printer = Adobe PDF

- Print Thumbnail borders OFF

- Colour output

- Margins all: 0.5cm

- Thumbs width 4.5cm, height 2.2cm

- Header: Resource icons xxx

- Header font 12 pt, Caption font 8pt

- Items for caption: only File name

- Files to process: Current folder

- Print Heading for each folder: OFF

- FINISH: provide file path for PDF file

Be aware that some file names are to long for complete dis-
play. In the tabular arrangement of the icons the names may 
overlap.

http://www.daube.ch/share/win15.html
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Commands
There are three command files in $HOME\fminit\configui:

cmds.cfg
mathcmds.cfg
wincmds.cfg

In the various views there are different versions of these files, 
since not all commands are relevant in a particular view.

For customisation it is not necessary to modify any of the 
standard command files. All customisation of commands is 
done in customui.cfg. and one or more menu files.

Note: A complete list of FM-13 commands can be found on 
www.daube.ch. These command lists are created with the free 
FrameScript Report FM Commands from itl.

Syntax peculiarity Inside a main definition (such as Command, Add, Order …) a 
blank must precede a nested option:

Invalid <Add MyCharOneQuarter<Menu SpecialCharsContext>> 

This definition will not become active.

Valid <Add MyCharOneQuarter <Menu SpecialCharsContext>> 

Command examples

For explanation of the keywords see Command statements on 
page 30.

Normal command <Command NewDocument Name of the command
<Label Document...> What you see in the menu
<KeySequence \!fn> Shortcut (ESC sequence)
<Definition \x300> FCODE, the command definition
<Mode All>> Valid contexts for this command

Command with restricted
context

<Command SelectAll
<ReservedLabel Flow Select All in Flow>
<ReservedLabel Frame Select All in Frame>
<ReservedLabel Page Select All on Page>
<KeySequence \!ea>
<Definition \x327>
<Mode All>>

Modify the shortcut <Modify SelectAll
 <KeySequence ^a> >

… and indicate it in the menu <Modify SelectAll
 <KeySequenceLabel CTRL+A> >

Combine these two
modifications

<Modify SelectAll
 <KeySequence ^a>
 <KeySequenceLabel CTRL+A >>

http://www.i-frame.itl.info/en/feature-description/free-scripts/report-fm-commands.html
http://www.daube.ch/docu/files/etb-fm13-commands.pdf
http://www.daube.ch/docu/files/etb-fm13-commands.pdf
http://www.daube.ch/docu/files/etb-fm13-commands.pdf
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Command statements

Command The command statement is the wrapper definition for the 
command:

Syntax <Command cmd-name <detail1> <detail2> <detailn>>

Details may be added to a command also by the Modify 
statement on page 31.

Cmd-name A unique name of the command. This serves as a reference 
between the various statement types.

Details For the detail specifications see Command details on page 32.

Examples See also Command examples on page 29.

<Command PrintingDisplay 
<ReservedLabel Document &Printing Display>
<KeySequence \!qqp >
<KeySeqLabel Esc q q p>
<Definition \x4F1 \x4F2 \x4F3 \x3F8>
<Mode All>>

Note: This command is defined by 4 function codes which imposes 
some problems. See the remark at Multi-code commands on 
page 38.

Custom command A custom command must not use an already existing name. 
Hence it is good practice to prefix the name with an indicator, 
for example:

<Command ETBVertToolBar …> Enhanced Toolbar
<Command _MTCharSet …> Microtype’s Customisation

ShiftCommand This statement defines a command for a menu item that is 
chosen while the Shift key is held down. This statement nor-
mally appears in a menu file (not a command file).

Syntax <ShiftCommand cmd-unshifted cmd-shifted>>

Cmd-unshifted This is the identifier of the command as it normally appears.

Cmd-shifted This is the identifier of the command you want to appear 
when you hold down the Shift key.

Examples <ShiftCommand Save SaveAll>
<ShiftCommand FindNext FindPrevious>

Note: 14)Commands defined by ShiftCommand can not be placed in 
context menus. The insertion of the command (by Add) does not 
create an error, although the command is not inserted. A fur-
ther Order command will not find the (not) inserted command 
and create an error. Example creating the error:

<ShiftCommand GraphicsObjProps GraphicsPickObjProps> ...
<Add GraphicsPickObjProps <Menu !GraphicsContextMenu>>
<Order !GraphicsContextMenu.GraphicsPickObjProps

<After !GraphicsContextMenu.GraphicsObjProps>>
Remove You can not remove commands. Only the menu entry is 

removed.

Syntax <Remove cmd-name <Menu menu-id>>

Examples <Remove GraphicsReshape <Menu GraphicsMenu>>
<Remove GraphicsReshape <Menu QuickGraphicsMenu>>

14 I have reported this as bug # 3494702 as of 2013-02-01.
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Modify statement

Modify The Modify statement is used to change details of a com-
mand. This command must be defined already. The change 
may affect:

 the label(s)

 the key sequence aka shortcut(s)

 the key sequence label(s)

Syntax <Modify cmd-name <new-detail1> … <new-detailn>>
<Modify cmd-name [context-id] <new detail>>

Cmd name This is the name (ID) of the command whose properties shall 
be modified

Details In the Modify statement the same details can be defined as in 
a Command statement. See Command details on page 32.

Modifications are cumulative for key sequences (short-
cuts)15). The other details are overwritten by the newest one.

Examples <Modify NewDocument
<KeySeqLabel Ctrl+N>>

<Modify TerminateMaker
<Label E&xit>> Define Label with access character

Renaming a context sensitive
command

To rename the label of a context sensitive command, both the 
command-name and the context-identifier (here: Frame) must 
be given:

<Modify SelectAll <ReservedLabel Frame Select Everything in 
Frame>>

Various labels for same
command

To get a different label for a command in only one place, 
define a new command that duplicates the function of the old 
one (using the same key sequence, definition, and mode), but 
use a different label. Then put the new command on the menu 
in place of the old one.

15 If a customisation file contains shortcut definitions for commands that 
already have shortcuts defined for them, warning messages may be writ-
ten to he console log file. This happens with ConfigWarnKbdRedundant = On 
in maker.ini (see [Preferences] in maker.ini).

http://www.daube.ch/docu/fmaker68.html#preferences
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Command details

Definition This defines the function of the command.

Syntax <Definition Fcode1 [Fcode2 … Fcoden]>

Fcode The function code is the connection between the command 
and the routine in the application which performs the func-
tion. A command may issue several functions, although most 
commands have only one Fcode associated.

The Fcode is noted as \xnnn with nnn being a hexadecimal 
number. You can find relevant Fcodes in the FDK16) documen-
tation or in the command files or in special lists derived from 
these files.

Examples <Definition \x300> Create new document
<Definition \x302> Command Help
<Definition \x3F1 \x3F2 > Borders and Text symbols On

Label The label defines the entry in a menu. It also provides a 
default for tool tips on buttons using this command.

Syntax <Label label-string defining the menu entry>

Label string If an ampersand character (&) is needed in the label-string, 
it must be doubled. This is due to the fact that the & precedes 
an access character. This will be underlined in the menu.

Example <Label P&rint Setup…> 

This will display in a menu as Print Setup…

ReservedLabel Some commands have a different label, and a different effect, 
depending on the context – where the insertion point is, what 
is selected, and so on. In these cases, the command gets a 
context-id defining the condition in which it can be chosen. 
Each of the conditions has a ReservedLabel statement.

Syntax <ReservedLabel context-id label-string>

Context-id The following context-ids are used in commands17):

16 In the FrameMaker Developer Kit (FDK) see include\fcodes.h 

Access character definition} }

Label KeySequenceLabel

Context-id Condition

Body Body pages are displayed

Book Book window is active

17 This table is deducted from the various cmdxxx.cfg files of FM-13. See 
also FP_EnabledWhen value in the FDK reference.
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Label string The same rules as with the Label detail apply. See Label on 
page 32

Example <Command SelectAll
<ReservedLabel Flow Select All in Flow>
<ReservedLabel Frame Select All in Frame>
<ReservedLabel Page Select All on Page>

... >>

The SelectAll command acts as a place holder on the menu 
for the group of commands: Flow, Frame, and Page, all of which 
have the same command definition.

KeySequence The key sequence defines a keyboard shortcut for the com-
mand.

Syntax <KeySequence sequence>

Ditamap Ditamap is active

Document Document is active

Flow Flow is selected

Frame Frame is selected

Generic Set up any generated file

History History window

Long, Long2 Complete (Long) menus is active

LongMultiple Multiple book components are selected

LongSingle Single book component is selected

MacEdition… Depreciated, since Macintosh is no more supported.

Master Master pages are displayed

NoDelete This page can not be deleted (e.g. Left/Right master page)

NoName This page has no name (not yet saved)

NotRegistered Product not yet registered

Other Other than body pages are displayed

Page A document page is active

Redo Undo command list

Reference Reference pages are displayed

Registered Product is registered

Repeat Repeat xxx

Scratch Probably a left-over from program development

Search AFAIK only used to search references.

Short, Short2 Short (Quick) menus is active

Straddle Selected cells are not straddled

Table Table is selected

TextInset Text inset is active

TOC, LOF, … Set up the respective generated file TOC, LOF, LOT, LOP, 
LOE, APL, AEL, LOM, AML, LOR, IX, AIX, SIX, IOM, IOR)

ToTable Selection is paragraph(s)

ToText Selection is a table

Undo Redo command list

Unstraddle Selected cells are straddled

Context-id Condition
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Sequence This defines the sequence of keystrokes. Two cases must be 
distinguished: Keys to be pressed together (key group) and 
keys to be pressed one after the other (key sequence). 

If you need the modifier key symbols literally in a sequence, 
the symbol must be preceded by a solidus (/). For example to 
use the ‘+’ in a key sequence literally, you provide ‘/+’.

Key group A base key is pressed together with modi-
fier keys. These modifier keys are defined 
with special symbols:

Escape key: \!
Shift key: +
Control key: ^
Alt key18): ~

A key group should not use more than two 
modifier keys, because humans have only 
two hands …

Key Sequence These sequences mostly start with the 
Escape key. Non-alphanumeric keys need a 
special notation19):

Escape key: \!
Function keys: /F1 … /F12
Insert key: /Insert

Note: Defining a key sequence must consider existing key sequences. 
If a key sequence ESC,q,q is already defined, ESC,q can no 
more be defied, because the input process waits for the next q. 
If You then enter just any other character (e.g. z), nothing will 
happen.
Existing key sequences mostly mimic the menu entries they 
support. They depend on the UI language. For example the 
sequence for Repeat last character modification is Esc,c,c in 
the English, and Esc,z,w in the German FrameMaker.

Examples <KeySequence +^b > Shift+CTRL+B (one key stroke)

<KeySequence \!/+c > Escape, Plus, c (three distinct key 
strokes)

Shortcuts on the Equations
palette

The shortcuts that appear on the Equations palette can not be 
customised. This palette is actually a special view-only docu-
ment containing hypertext commands. The same is true for 
the Vertical Toolbar.

KeySequenceLabel The key sequence label is added to the right side of a menu 
entry.

Syntax <KeySeqLabel descriptive-string>

18 On European keyboards the right Alt key is engraved AltGr (Alternate 
Graphic). Pressing this key together with another key types the special 
graphic engraved at lower right of the symbol key. AltGr is equivalent 
to Alt+Ctrl.

19 Since Windows 95 the following keys available only on Windows Key-
boards can no more be used for short cuts in FrameMaker:
Application Key – also called Menu Key (/Apps) right of the space bar. Its 
standard function is to open the context menu of an application.
The Windows logo key (/Win) left of the space bar is used for various Win-
dows functions, for example, to open the Start Menu. See Wikipedia. 

http://en.wikipedia.org/wiki/Windows_key#Use_with_Microsoft_Windows
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Descriptive string This echoes the key sequence of the command. You should 
distinguish the two cases of key sequences by different nota-
tion:

Key group Key names concatenated with a ‘+’ sign.

Key sequence A list of key-names (separated by blank or 
comma).

Examples <KeySeqLabel CTRL+A> Key group
<KeySeqLabel Escape, q, q, e> Key sequence
<KeySeqLabel Esc q q p> Key sequence
<KeySeqLabel ALT+Shift+F9> Key group

Note: If a command does not have a KeySeqLabel detail, the com-
mand will be displayed on the menu with no shortcut. This 
does not mean the shortcut does not exist; it just means the 
shortcut is not displayed on the menu.

Mode The Mode defines the validity of a command for a particular 
environment. 

Syntax <Mode mode >

Mode Defined modes (used in commands) are:

Example <Mode NonMath >

AsianFonts To define a command that appears in menus only if your sys-
tem supports typing Asian text in documents and dialogue 
boxes, use this detail:

Syntax <AsianFonts Yes>

Note: AsianFonts No has the same effect as omitting the statement. 
In this case the command applies to all configurations.

Mode

All The default

Math During Equation editor

NonMath Anything but Math
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Some particularities of commands

Hypertext commands  The following hypertext commands can not be used in 
menu or tool bar: newlink, gotolink, gotolinkfitwin, 
previouslink and previouslinkfitwin.

See a synopsis of the hypertext commands at Synopsis of FM 
hypertext commands on page 51.

 It is not possible to define shortcuts for hypertext com-
mands. For example, the shortcut defined in the Modify 
statement is not executed:

<Command Test1 <Label Using FrameMaker 11>
<Hypertext message openfile H:/…/etbfm11-help.pdf>>

<Modify Test1 <KeySequence \!qqq>
<KeySeqLabel Escape q q q>>

 Hypertext commands do not work in books, neither do 
shortcuts to hypertext commands in a book window.
Although it is possible to define an entry in a book menu 
for such commands , they are inactive (greyed out).

 It is possible to define FM read only documents containing 
buttons with hypertext commands. Examples are the Equa-
tions palette and the Vertical tool bar. See more on this 
method on www.daube.ch.

Hypertext commands in 
tool bars

In tool bars the same hypertext commands as in menus are 
possible. However, they do not work, if the command is only 
used in the toolbar. Hence it is necessary to at least define a 
dummy menu entry. See Menu and tool bar files on page 54.

Note on drop-down lists More than one drop-down list can appear in a tool bar20):

Scripts as commands

Binary scripts Binary scripts (*.jsxbin) must reside in the Startup folder of 
the user area. They define the command name and a menu 
where used (See Menu and tool bar files on page 54).

Binary scripts can not be addresses by a hypertext commands 
21).

The general procedure is this [Ric Quatro]:

1 Create a new custom command in your script.

2 Use the built in Command function to wait for the custom 
command to be invoked and have it call a function with 
your simple code in it.

3 Compile the script to a jsxbin and install it in the Startup 
folder.

20 Example provided by Shmuel Wolfson.
21 This is, because no program association can be defined for such files. A 

xxx.jsxbin file would just be opened in Notepad and of course presents 
gibberish.

http://www.daube.ch/docu/files/palette-internals-0.pdf
https://forums.adobe.com/thread/2299092
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Note: See File simple.jsx on page 17 for an example. This will, how-
ever run at start of FM also, not just on demand by a button or 
menu. To avoid running at start of FM you need to add a 
Notify function:

function SetupNotifications () { // Watch for the following notifications ==================
  Notification (Constants.FA_Note_PostActiveDocChange, true);  
} // --- end SetupNotifications

function Notify (note, object, sparam, iparam) {  // Handle triggered events ===============
  if (typeof  wSaveOld == "undefined") {return;}  // just started in StartUp folder
  switch (note) {
  ...
} // --- end Notify

The item in red is the name of the window (dialogue, panel) 
object.

Source scripts Source scripts (*.jsx) can reside in the Startup folder of the 
user area, but also in the general script folder at 
%userprofile%\Documents\Adobe Scripts.

Simulating alert and 
alerttitle

The following ExtendScript is a replacement for the alert/
alerttitle hypertext commands:

// ETBnudge.jsx
// to be placed in C:/Users/Klaus/Documents/Adobe Scripts/
#target framemaker

var msgtitle = "Nudging objects";
var msg =  "At zoom 100% unit is 1pt; at zoom 353% unit is 0.1mm"

+ "\n• Use ALT+arrow to nudge 1 unit"
+ "\n• Use SHIFT+ALT+arrow to nudge 6 units"
+ "\n\nATTENTION: SHIFT+ALT (without arrow) changes the system locale."
+ "Check your system tray, if keyboard behaves strangely!";

alert(msg, msgtitle);

Keyboard shortcuts For ordinary commands (not hypertext commands) keyboard 
shortcuts can be redefined. However, this will provoke a log 
message if ConfigWarnKbdOverride = On is set in maker.ini. 
Even an unmodified FM-UI will issue such messages22).

If the same short cut is given more than once to a command, 
another message is issued if ConfigWarnKbdRedundant = On is 
set in maker.ini 23). This happens in particular for settings 
both in configui\customui.cfg and in the menu file in 
%appdata% – which is common for many UI modifications.

Command overloading A command (name) can be redefined24).Initial definition:

<Command Test2
<Label Using FrameMaker 11>
<Hypertext message URL http://help.adobe.com/en_US/.../11.0/Using/index.html>
<KeySequence \!qqq>
<KeySeqLabel Escape q q q>>

22 For example: The shortcut !ph in file FMPublisher overrides one or more 
previous shortcuts.

23 For example The shortcut !SFL in file 
$HOME\fminit\configui\structured\wysiwygview\wincmds.cfg is a dupli-
cate of an existing shortcut.

24 Lynne Price, 2014-10-23
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Later definition <Command Test2
  <Hypertext alert Test2 is testing hypertext> >
<Add Test2 <Menu ViewMenu>>

Result The shortcut ESCqqq brings up an alert that says “Test2 is test-
ing hypertext”.

Multi-code commands For multi-code commands only two of the three UI elements 
may be defined: button, menu item, shortcut. If all three are 
defined, then only the first code will be executed.25)

For the following no menu item will be defined:

<Command EditingDisplay
<ReservedLabel Document &Editing Display>
<KeySequence \!qqe >
<KeySeqLabel Esc q q e>
<Definition \x3F1 \x3F2 >
<Mode All>>

And for the following only a menu item (and no shortcut or 
button) will be defined:

<Command ETBGoToMasterPage   
<Definition \x343 \x345  > 
<Label Go to a Specific Master Page... >> 

<Add ETBGoToMasterPage <Menu ViewMenu>>
<Order ViewMenu.ETBGoToMasterPage 
<Before ViewMenu.ViewMasterPages>>

OWL commands The new interface requires special commands:

Show next tab in panel group <Command ShowNextKit
   <Label Show Next>

<KeySequence ^ /F6>
   <Definition \x971>
   <Mode All>>

Show previous tab in panel
group

<Command ShowPrevKit
   <Label Show Previous>

<KeySequence ^ +/F6>
   <Definition \x972>
   <Mode All>>

??? <Command ThemeLoad
   <Label LoadTheme...>

<KeySequence \!LT>
   <Definition \x974>
   <Mode All>>

??? <Command ThemeSave
   <Label SaveTheme...>

<KeySequence \!ST>
   <Definition \x975>
   <Mode All>>   

Toggle between the
following 3 screen modes

<Command ToggleScreenMode
   <Label Toggle Screen Mode>
   <KeySequence ~+/Return>
   <KeySequence \!SMt>
   <Definition \x978>
   <Mode All>>   

25 This is a problem since FM-9 and is most likely a consequence of the new 
user interface.
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Standard mode (UI, normal
size)

<Command SceenModeStandard
   <Label Standard Screen Mode>
   <KeySequence \!SMs>
   <Definition \x979>
   <Mode All>>   

Full width with UI <Command ScreenModeFullWithUi
   <Label Full Screen Mode with UI>
   <KeySequence \!SMu>
   <Definition \x97A>
   <Mode All>>   

Full screen, no UI <Command ScreenModeFullScreen
   <Label Full Screen Mode>
   <KeySequence \!SMf>
   <Definition \x97B>
   <Mode All>>   

Peferences > Interface <Command UiPreferences
<Label Interface...>
<KeySequence \!ip>
<Definition \x980>
<Mode All>>

Preferences > Alert Strings <Command UiAlertStringsPreferences
<Label Alert Strings...>
<KeySequence \!asp>
<Definition \x981>
<Mode All>>

Show all tool bars <Command ToolBarShowAll
<Label Show All>
<KeySequence \!TSA>
<Definition \x989>
<Mode All>>

Hide all tool bars <Command ToolBarHideAll
<Label Hide All>
<KeySequence \!THA>
<Definition \x98A>
<Mode All>>

Some graphic commands

Keep next selected graphic
tool active

<Command GraphicsKeepTool
<Label Keep Tool>
<KeySequence \!gk>

This keeps the next selected graphic tool active until 
SmartSelectionTool is activated.

Operate on hot spot graphic <Command GraphicsCreateLink
<Label Create Link to graphic...>
<KeySequence \!gcl>

Operate on hot spot graphic <Command GraphicsCreateLinkTable
<Label Create link table for graphic...>
<KeySequence \!gct>

Dead commands Following commands do nothing (FM-9 … 13):

<Command !WindowOpen** Not supported on all platforms **
<Label Open>
<KeySequence \!wo>

<Command ViewPublisherBoundaries
<Label Publisher Boundaries>
<KeySequence \!vl> (lowercase L)

<Command ReportCmds_byShortcut
<Label Report Commands by Shortcuts>
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<KeySequence \!SCR2>

Viewer popup command The commands for the viewer (and a locked document) also 
work in the ordinary edit window:

Command KeySequence Definiiton

GotoNextPage \!pn \x34D
GotoPreviousPage \!pp \x34C
GotoFirstPage \!pf \x340
GotoLastPage \!pl \x341
GotoPreviousScreen \!vsp \xD40
GotoNextScreen \!vsn \xD41



24 – 41

Commands
D

E
:\

_D
D

D
p

ro
je

ct
s\

FM
-t

o
o

lb
a
r0

0
\A

ll
E
T

B
\e

tb
-c

u
st

o
m

is
in

g
-f

m
1

2
.f

m
 

2
0

1
7

-0
4

-2
4

Command names from plugins and scripts

Available commands have various sources. Even native 
FrameMaker comes with plugins: mapper.dll, masterpages.dll 
etc. Most installations add scripts, both started automatically 
or on demand.

To be able to set up custom menus and tool bars it is neces-
sary to get the command names from these sources. The best 
method is to use the free FrameScript Report FM-commands 
from itl.

Plugins For example, the plugin AutoText.dll from Silicon Prairie 
Software creates commands which depend on a table in the 
related document AutoText.fm. This is an excerpt of these 
commands from my personal settings in the table:

ExtendScript ExtendScript simple.jsx (see File simple.jsx on page 17) creates 
the following commands: 

You see that there is no relation between the script file name 
and the command names.

Keyboard shortcuts for 
ExtendScripts

The above example does not define keyboard shortcuts for 
the menu entries, because at that time I did not know how to 
do it.

Define shortcuts To define a shortcut the last parameter in DefineAndAddComand 
gets the key-sequence. Be aware to double the \ for the ESC 
notation (ESC,q,j and ESC,q,f). See KeySequence on page 33.

You also want to indicate these shortcuts in the menu entries. 
There are two methods:

Shortcut label by TAB As known from the example (ExtendScript on page 41) the fol-
lowing actually precedes the Define Shortcut section in the 
script:

var oMenus = {}, menuLocation, simpleMenu;
oMenus.MenuMain = "Test Alerts";
oMenus.MenuJS = "Alert by JS\tESC,q,j";
oMenus.MenuFM = "Alert by FM\tESC,q,f";

menuLocation = app.GetNamedMenu("!MakerMainMenu");
simpleMenu = menuLocation.DefineAndAddMenu("Simple", oMenus.MenuMain);
simpleMenu.DefineAndAddCommand(1,"msgJS","JS alert","\\!qj");
simpleMenu.DefineAndAddCommand(2,"msgFM","FM Alert","\\!qf");
UpdateMenus();

function Command(cmd){
  switch(cmd) {
    case 1:

Command name Command label Shortcut FCode

Editors note in frame  [ctrl+3] Editors note in frame  [ctrl+3] Ctrl+3 1400DF0

Callout figure [ctrl+4] Callout figure [ctrl+4] Ctrl+4 1410DF0

Frame outside column [ctrl+4] Frame outside column [ctrl+4] Ctrl+5 1420DF0

Icon frame [ctrl+6] Icon frame [ctrl+6] Ctrl+6 1430DF0

Command name Command label FCode

msgJS JS alert 18B0DF0
msgFM FM Alert 18C0DF0

http://www.i-frame.itl.info/en/feature-description/free-scripts/report-fm-commands.html
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      alert (msg1, "Message title");
      break;
    case 2:
      Alert(msg2, Constants.FF_ALERT_CONTINUE_NOTE);
      break;
  }
}

Explicit definition
of Shortcut label

The command property KeyboardShortcutLabel is used for this 
method. To me it is not clear why this is a property of the 
command and not of the menu item.

var oMenus = {}, menuLocation, simpleMenu, commandJS, commandFM;
oMenus.MenuMain = "Test Alerts";
oMenus.MenuJS = "Alert by JS";
oMenus.MenuFM = "Alert by FM";
commandJS = 1,"msgJS","JS alert","\\!qj");
commandJS.KeyboardShortcutLabel = "ESC,q,j";
commandFM = 2,"msgFM","FM Alert","\\!qf"
commandFM.KeyboardShortcutLabel = "ESC,q,f";

menuLocation = app.GetNamedMenu("!MakerMainMenu");
simpleMenu = menuLocation.DefineAndAddMenu("Simple", oMenus.MenuMain);
simpleMenu.DefineAndAddCommand(commandJS);
simpleMenu.DefineAndAddCommand(commandFM);
UpdateMenus();

function Command(cmd){
switch(cmd) {
    case 1:
      alert (msg1, "Message title");
      break;
    case 2:
      Alert(msg2, Constants.FF_ALERT_CONTINUE_NOTE);
      break;
  }
}
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FrameScript

Note: This example is part of the download of FM-customisation-
example.zip.

Ordinary scripts get generic names (ESLRUNxxx) which may 
change form FrameMaker start to start. Hence a menu or tool 
bar using these can not be distributed to other installations.

To get a static command name to be used in a menu or tool 
bar the script must be set up as an EventScript.

 EventScripts must be installed, not just run.

 In an EventScript commands must reside within Events.

 Menus and commands are defined within the Event 
Initialize.

 It is good practice to remove the menu with Event 
Terminate.

 A menu item is not necessary, if the command is used in a 
toolbar only.

The installed script FrameScript primitive.fsl (see File 
primitive.fsl on page 17) gets the following properties:

Note: Be aware that the FCodes generated for the script may differ 
from FM session to FM session! Hence do not use them.

Installing the example script

Since this example script has no menu entry, you do not see 
an action of it as long as you do not have a toolbar with a but-
ton …

Command name Command label FCode

ESLSSRUN306 Primitive 18E0DF0
ESLSSRUN307 Something Else 18F0DF0

Command name Command label FCode

MyCommand1 My Command 1 A0DF0

http://daube.ch/docu/files/FM-customisation-example.zip
http://daube.ch/docu/files/FM-customisation-example.zip
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Menu statements

Note: Commands do not need a corresponding menu entry. They 
may be invoked by a keyboard short cut or a button only.

Menu A new menu or sub menu is defined with this statement:

Syntax <Menu menu-name <Label menu-label>>

Examples <Menu ETBmenu <Label Enhanced Toolbar (ETB)>>
<Menu ETBlocalDocuments <Label Local documentation (pdf)>>

Reserved menu Many of the menus defined in the standard menu files for 
FrameMaker are reserved menus. FrameMaker has intrinsic 
knowledge about reserved menus; it can refer to these menus 
directly by name.

Syntax <ReservedMenu !menu-name <Label menu-label>>

Menu-name FrameMaker relies on Permanent menus and also on Context 
menus. Both are defined with the ReservedMenu statement in 
the standard menu files. Custom menus must not use names 
of these reserved menus. It is a good idea to prefix custom 
menu names by a project abbreviation. For example, ETBmenu 
or !_MTmenu. 

Menu-label The Label detail is the same as for commands, because the 
command is represented in the menu item. See Label on 
page 32.

Reserved menus By convention, the names of reserved menus begin with an 
exclamation point (!). The highlighted items in the table are 
permanent menus26).

26 This table is deducted from the various cmdxxx.cfg files of FM-13. 

Menu ID Description

!BookMainMenu Menu bar for complete menus (book window active)

!CustomMakerMainMenu Menu bar for custom menus (document window active)

!EmbeddedObjectMenu Submenu Edit > Object

!HelpMenu Menu Help

!MakerMainMenu Menu bar for complete menus (document window active)

!MenusMenu Submenu View > Menus

!MSWindowMenu Menu Window

!QuickBookMainMenu Menu bar for quick menus (book window active)

!QuickMakerMainMenu Menu bar for quick menus (document window active)

!RulerAlignMenu ¶-alignment pop-up menu in the formatting bar

!RulerAlignMenu ¶-alignment pop-up menu in the formatting bar

!RulerControlMenu Formatting bar: commands !ShowRulerToggle, 
!ShowRulerAlignmentSpacingAndTabs and !ShowRulerParagraphTags – 
all with an empty defintion (\x0).

!RulerParaMenu ¶-formats pop-up menu in the formatting tool bar

!RulerSpaceMenu Line-spacing pop-up menu in the formatting tool bar

!StructureViewMainMenu a Structure menu bar (structured product interface only)

!ViewOnlyMainMenu a View-only menu bar

a. Not used in any of the FM-13 *cfg files - depreciated?
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Permanent menus FrameMaker relies on some menus existing. In the table of 
Reserved Menus their ID is bold. You cannot remove these 
menus from a menu configuration file. FrameMaker will not 
work properly without them.

Context menus The default context menu for a particular selection does not 
contain every possible command. If a menu item is not appli-
cable to the selection and the current state of FM, he menu 
item will be dimmed.

Context menus can not contain shifted commands. See 
ShiftCommand on page 30).

Context menus can also be displayed by pressing Shift+F10. 
In this case, the appearing menu depends on whether there 
exists a selected object, an insertion point, or neither.27)

Add This statement adds an item to a menu at the end of the 
already existing entries. Hence normally a corresponding 
Order statement exists in a customisation file.

Syntax <Add command <Menu menu-name>>
<Add submenu-name <Menu menu-name>>
<Add Separtorn <Menu menu-name>>

Command This identifies an already defined command.

Submenu-name This identifies an already defined menu.

27 This table is deducted from the various cmdxxx.cfg files of FM-13. See 
also FP_EnabledWhen value in the FDK reference.

Context menu id Object providing the context

!AnchoredFrameContextMenu an anchored frame

!AutoSpellCheckContextMenu
!BookContextMenu a book window

!DocumentContextMenu the document as a whole (no active insertion point and nothing selected)

!EmbeddedObjectContextMenu an OLE object

!GraphicsContextMenu all graphic objects except an anchored frame

!MathContextMenu an equation

!MultiGraphicsContextMenu any grouped graphic object

!QuickBookContextMenu a book window when Quick Menus is the current menu set up

!StructureContextMenu the Structure View in FrameMaker+SGML

!StructuredTextContextMenu text in a structured text flow in FrameMaker+SGML

!TableContextMenu a table

!TableTextContextMenu text in a table

!TextContextMenu text

!TextLineContextMenu text line selected as text

!TextLineGraphicContextMenu text lines selected as graphic objects

!ViewerPopup a View-only document window

!ViewOnlyBookContextMenu a View-only book window

!ViewOnlyDitamapContextMenu DitaMap

!ViewOnlyDitamapContextMenuCon
tainer
TableMenuInTextContextMenu
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Menu-name Name of the menu to which the command or sub-menu shall 
be added.

Separatorn Within a menu the separators must be numbered to get 
unique names for an Order statement.

Examples <Add Open <Menu FileMenu>>
<Add ETBspecial <Menu ETBmenu>>
<Add Seaprator5 <Menu ETBmenu>>

Order This statement defines where a menu entry shall be placed in 
the menu.

Syntax <Order menu.new-item <First menu>>
<Order menu.new-item <Last menu>>
<Order menu.new-item <Before menu.ref-item>>
<Order menu.new-item <After menu.ref-item>>

Menu The menu we are talking about, defined by a Menu statement.

New-item The item to be placed. It has been defined in the menu.

Ref-item The reference item in menu relative to which the new item is 
inserted.

Examples <Order !TextLineContextMenu.SpecialCharsContext
<Before !TextLineContextMenu.Undo>>

<Order !TextLineContextMenu.Separator1
<Before !TextLineContextMenu.Undo>>

<Order ViewMenu.ViewGraphicsOn
<Before ViewMenu.Separator3>>
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Workspace definition
Workspaces are defined in files xxx.cfws (current) and xxx.fws 
(last saved). In most cases we need not create or modify 
(besides line 2) such a file.

Modify or create 
workspace

Menus and toolbars appear in a view due to the file location 
of them. Multiple workspaces can be defined for a particular 
view. Activating a newly introduced toolbar (docked or 
undocked) modifies the current workspace, which can be 
saved to a new name.

workspace file The following is the definition of custom workspace 
Custom.cfws which refers to a custom menu file and a custom 
tool-set file (long lines are truncated to display the structure):

Key in the workspace file are the palette and control-bar 
statements, which hold various information about the panels 
and toolbars.

Note: For customisation we are normally only dealing with the sec-
ond line which defines the menu set and the toolbar set. 
Be aware that xml comments are removed from workspace 
files!

Size of toolbar Only if a drop down box appears in the toolbar you may need 
to adjust the size parameters in the control-bar statement. 
You do this after the workspace file has been created. Nor-
mally you adjust the parameters size = preferred-size and 
then minimum and maximum.

<control-bar id="004C0966" origin="874 31" size="255 34" is-closed="false" app-

<FrameUI version="1">
<data type="all" menuFile="custom_menus.cfg" toolbarFile="custom_toolset.xml"/>
<fm-workspace>

<workspace version="1">
<dock anchor="left" content="palette toolbar" is-closed="false"/>
<dock anchor="right" content="palette toolbar" is-closed="false">

<tab-pane mode="expanded" preferred-iconic-length="0" layout-mode="auto-flow">
<tab-group active-palette="00070CB2" is-closed="false">

<palette id="00070CB2" is-closed="false" preferred-unconstrained-size="135 
<palette id="00060F46" is-closed="false" preferred-unconstrained-size="135 
<palette id="000A10CE" is-closed="false" preferred-unconstrained-size="135 
<palette id="00060BAA" is-closed="false" preferred-unconstrained-size="135 

</tab-group>
<tab-group active-palette="00060DD6" is-closed="false">

<palette id="000C1118" is-closed="false" preferred-unconstrained-size="317 
<palette id="00060DD6" is-closed="false" preferred-unconstrained-size="359 

</tab-group>
</tab-pane>

</dock>
<dock anchor="top" content="multi-control-bar" is-closed="false">

<control-bar-pane >
<control-bar id="00060B9A" origin="4 35" size="858 34" is-closed="false" app-

</control-bar-pane>
</dock>
<dock anchor="bottom" content="palette" is-closed="false"/>

</workspace>
</fm-workspace>

</FrameUI>

1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
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data="#lt;control-bar cb-data=#quot;custom_tb#quot; minimum-size=#quot;240 34#quot; maximum-
size=#quot;300 34#quot; preferred-size=#quot;255 34#quot;/>"/>

Custom menu If you want to refer to a custom menu you will change the ref-
erences in line 2, for example 

from
<data type="all" menuFile="menus.cfg" toolbarFile="fmtoolbar.xml"/>

to
<data type="all" menuFile="custom_menus.cfg" toolbarFile="fmtoolbar.xml"/>

You also need to set up a menu file custom-menus.cfg. and 
place it in appropriate directory.

Custom toolbar set If you want to refer to a custom toolbar set, you will change 
the references in line 2, for example

from
<data type="all" menuFile="menus.cfg" toolbarFile="fmtoolbar.xml"/>

to
<data type="all" menuFile="menus.cfg" toolbarFile="custom_toolbar.xml"/>

You will set up a corresponding list of toolbars in 
custom_toolset.xml. This list refers to the individual tool bar 
files.

Note: Toolbars containing a drop-down list can not be docked left or 
right to become oriented vertically!
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Initialisation files maker.ini and others
The *.ini files are a standard Windows initialisation files 
which are divided into sections. Section names are enclosed 
in brackets. The equal sign may be surrounded by spaces:

[Frame]
ProductInterface=FrameMaker
; Comment lines start with a semicolon.

The coding of these files vary. Most use the Windows cp 1252, 
maker.ini uses UTF-8.

When opening an initialisation file in FrameMaker, assure to 
open it as Text. When you’re finished editing the file, use the 
Save As command to save it as Text Only.

For FM-13 the maker.ini file comprises about 350 entries. 
Some of them are necessary to get back the behaviour of pre-
vious FM-versions , for example

SymbolSortingBeforeAlphaNumeric = On

Since FM-7.1 the file in $HOME is considered the master file and 
only the file in the user-area is modified individually. These 
files are now coded in UTF-8. Nevertheless special characters 
can be defined in the traditional way using :

FindSpaceBefore=On !%),.:;?]}\u00bb\u201d\u2019\u203a
;SmartQuotes \xd4\xd5\xd2\xd3 )  English curved quotes
SmartQuotes=‘’“”

The last line shown above uses the Unicode of the characters, 
while the comment line uses the traditional FrameRoman 
notation.

Of course it is possible to establish a complete copy of the 
$HOME file in the user-area and then open FrameMaker. How-
ever, some entries, such as ProductInterface are not present 
in the main file. They describe items which might differ 
between users of the same system.

Other ini files Special features are supported by additional ini files28):

Initialisation file Purpose, used by

AuthorView.ini Set-up of the Author View 

ditafm-output.ini Set-up for DITA output processing

ditafm.ini Set-up for DITA processing

DynaHelpPreview.ini Publisher: Dynamic Help extension

MathFlowPlugin.ini Set-up of the none-Adobe plug-in MathFlow

ModalDialogPosition.ini Save the current positions of the modal dialogues

pdfsize.ini Settings from Format > Document > Optimise PDF 
Size > Options

SkinGallery.ini Publisher: skins (WebHelp, WildFire, AirHelp)

sqPalmXmlViewer.ini Publisher: Palm xml viewer

sqSkin.ini Publisher: sqSkin extension

WHATSTHS.INI Set-up for the What’s This function of Publisher

XmlCodeView.ini Set-up of the XML Code View

28 List according to FM-13 installation.
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Entries in ini files To a void redundancy I do not list the entries of maker.ini 
and other ini files here. Look at www.daube.ch for a main-
tained list.

Note: Since FM-12 Adobe maintains a document describing the 
entries in maker.ini - See Help > Help Topics > 5th icon 
(FrameMaker Help Center) > FrameMaker Resources.

http://www.daube.ch/docu/fmaker68.html
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Synopsis of FM hypertext commands

Command 
(drop down list in FM)

Syntax Example d) Valid in

Doc PDF e) HTML f) Menu/TB g)

Alert h) alert text alert Time for lunch now!i) Y Y N Y

Alert with title h) alerttitle title:text alerttitle Hello - I’m the title:This is in 
the first line\x0dand this is in the next. Y Y N Y

Specify named destination newlink name newlink here_we_go Y Y Y N

Jump to named destination
Jump to … and fit to page

gotolink name
gotolinkfitwin path:link

gotolink hereafter
gotolinkfitwin hereafter Y Y

Y
y

N

Jump to first page in file j)

Jump to last page in file
gotolink path:firstpage
gotolink path:lastpage

gotolink dummy.fm:firstpage
gotolink dummy.fm:lastpage Y Y N Y

Jump to page number gotopage path:pagenumber gotopage dummy.fm:2k) Y Y N Y

Jump to previous page / next 
page of current document

previouspage
nextpage

previouspage 
nextpage Y Y N Y

Jump back (to last view)
Jump Back & Fit To Page

previouslink
previouslinkfitwin 

previouslink 
previouslinkfitwin Y N N N

Open document 
Open document … and fit to page 
(same type as source: fm or pdf) i)

openlink path
openlinkfitwin path

openlink dummy.fm
openlinkfitwin dummy.fm Y Y Y

Y
Y

Open Document As New opennew path opennew H:/Adobe/framemaker.13en/
AdobeFrameMaker2015/Templates/Book/Chapter.fm Y N N Y

Open document at first/last 
page j)

openlink path:firstpage
openlink path:lastpage

openlink dummy.fm:firstpage
openlink dummy.fm:lastpage Y Y Y Y

Open document at page number openpage path:pagenumber openpage dummy.fm:2 Y Y Y Y

Go to URL message URL url message URL http://www.daube.ch/docu/
fmaker00.html Y Y Y Y

Message client: Open document 
with associated application

message openfile pathl) message openfile C:\Windows\win.ini 
Y Y N Y m)

Launch Windows application message winexec application 
path[,windowstate]n)

Start the Windows calculator
(C:\WINDOWS\System32\calc.exe) Y N N Y

Time for a break now, buddy 
The maximum length of the marker text is 255 chars (until FM-11) and 1023 chars (from FM-12 onwards).

Hello - I’m the title: This is in the first line And this  (after a carriage return=x0d - escaped) is in the second Even more lines are possible, The maximum length of the marker text is 255 chars (until FM-11) and 1023 chars (from FM-12 onwards).

http://www.daube.ch/docu/fmaker00.html
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Notes d Be aware that not all examples will work on your 
system.

e M: equivalent function from Acrobat menu 
available.

f Y = works in principle, but certain restrictions 
apply.

g Hypertext commands indicated with Y work in 
menus.cfg files. The same commands work in toolbar 
files (e.g. quick-access.xml) only, if also used in a 
menu! This can be a menu which is not inserted in an 
existing menu (I call this an orcus-menu). See Menu and 
tool bar files on page 54.

h In PDF this will be a text note, the title will not 
be presented as such, but stay within the text. 
See also Difference in presentation on page 53.

i To get line breaks in the alert and alerttile 
display, use \x0d in the FM-document and \x09 

in command config files. Inspecting the hyper-
text marker later will display the \x0d as blank.
A tab may be inserted as \r in the FM document 
and as \x08 in config files.

j FrameMaker hyperlinks have two variations: 
goto and open.The goto variation displays the 
target document in the current window (closing 
the currently-displayed file); the open variation 
displays the target document in a new window, 
leaving the current document open. If you hold 
the Shift key when activating a link/cross-ref 
with Ctrl+Alt/link (that is, 
Ctrl+Alt+Shift+click), the goto... is inter-
preted as an open... action (and vice versa).

k The current document will be closed (user 
prompt, if edited), before the linked document 
is opened. “Jump Back” opens the current docu-
ment again.

Popup menu
(works only in FrameMakerView 
mode)

popup textflow_on_refpage popup popup1

The marker in the text flow contains a hyper-
text command gotolink xxx with xxx being 
the name in a hypertext marker newlink xxx at 
the location to be jumped to with the menu. Y o) N N N

Button matrix matrix nrows ncolumns flowname Equation palette, Vertical toolbar Y N y N

Close current window quit quit Y M N N

Close all hypertext windows quitall quitall Y M N N

Exit Framemakter application exit exit Y M N N

Command 
(drop down list in FM)

Syntax Example d) Valid in

Doc PDF e) HTML f) Menu/TB g)

Popup Menu Sample
Variables6
Cross references6
Update references6
Footnotes6
Hyperlinks6
Bibliographies6
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Synopsis of FM hypertext commands
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l For this command both the backslash and the solidus are 
allowed in path names.

m If the file is a binary script, it will be opened in Notepad 
rather than executed.

n The window state is a string constant such as 
SW_SHOWMAXIMIZED (see help for more).

o To test a popup switch the document to View only by lock-
ing it. The flow with same name as the popup must be 
located on a reference page.

File paths In file paths or URLs the backslash is not valid. The solidus 
(normal slash) must be used. Both absolute and relative paths 
(relative to current document) are possible.

same folder message URL file.ext

sub-folder message URL subfolder/file.ext

parallel folder message URL ../folder/file.ext

one level above message URL ../../upperfolder/file.ext

Target of gotolink This destination is used in the example hyperlinks above.

Difference in 
presentation

Both in the FM document and in the cfg files the carriage 
return and the TAB need unusual coding.

In FM document alerttitle The title line:Some text in line one\r\x09Just 
after a tab\r•\x09Bullet, then TAB\rSome bullet characters:• 
¤ » …

In the document the hypertext command uses Unicode which 
gives a rich set of special characters. The contents of the 
hypertext statement is listed hereafter.

In cfg file The cfg files must be in Windows 1252 code page and use the 
FrameRoman coding for special characters. 

<Command Test01 <KeySequence \!991>
<Hypertext alerttitle The title line:Some text in line 

one\x09\x08Just after a tab\x09\xe2\x08Bullet, then 
TAB\x09Some bullet characters:\x09\xdb (db) \xe2 (e2) \xc8 
(c8) \xc9 (c9) >>

The title line:Some text in line one
	Just after a tab
•	Bullet, then TAB
Some bullet characters:• ¤ » …



Customising FrameMaker 12/13

24 – 54

Menu and tool bar files

menus.cfg

Command definition
<Command ETBtest1 <Label ETB test hypertext commands>

<Hypertext alerttitle Test Hypertext Commands: Just a simple text to test the West\x09And 
this is on the next line>>
<Command ETBtest2 <Label ETB test hypertext commands>

<Hypertext message openfile C:/Users/Klaus/Documents/Adobe Scripts/ETB/ETBnudge.jsx>>

Use in orcus-menu An orcus menu (my personal naming) is a dead end. It is not 
connected to any existing menu, hence not visible.

<Menu ETBDummy                <Label Orcus for toolbar commands only>>
<Add ETBtest1 <Menu ETBDummy>>
<Add ETBtest2 <Menu ETBDummy>>
quick-acess.xml <ACTION command="ETBtest1">

<images base="etb_icons\testing"/>
</ACTION>
<ACTION command="ETBtest2">

<images base="etb_icons\testing"/>
</ACTION>
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